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Burner Fire 
In this tutorial you will create a 500 kW burner fire and measure the temperature in the center of the 

plume at a height of 1.5 m. This example defines a fire by specifying a Heat Release Rate (HRR). This is 

both the simplest and most commonly used approach for fire safety engineers to represent fire. 

For this example, it is sufficient to understand that modeling a fire using the heat release rate requires 

the user to specify two pieces of input data: 

• A reaction that defines the products and energy release during combustion and, 

• A heat release rate (HRR) that defines the size of the fire. When HRR is specified, FDS uses the 

reaction energy to calculate the corresponding fuel mass flow rate from the surface. 

Once the reaction and heat release rate are defined, gaseous fuel flows from the surface, mixes with air, 

and reacts to form combustion products (including heat). A longer (but still brief) introduction to fire 

modeling is given in the Room Fire example. 

 

Figure 1. Burner fire in this example 

This tutorial demonstrates how to: 

• Create a burner fire. 
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• Add a thermocouple. 

• Add a slice plane for temperature visualization. 

• View 3D results using PyroSim Results. 

• View 2D results using PyroSim. 

Throughout this example, the instructions will describe data input using menu dialogs. This is done for 

clarity and consistency. However, PyroSim provides both drawing tools and shortcut toolbars that can 

speed many of these tasks. The user is encouraged to experiment with these alternate approaches to 

model creation. 

Select SI Units 
To select SI units: 

1. On the View menu, click Units and select SI to display values using the metric system. 

Create the Mesh 
In this example we will use mesh cells that are 0.1 m across. This value is somewhat smaller than 1/5 of 

the characteristic diameter (D*) for a 500 kW fire. As a rule of thumb, recommended cell sizes range 

from 1/5 to 1/20 of D* to ensure at least a moderate level of accuracy in modeling the plume 

(McGrattan, Kevin, et al. 2014). Using mesh cells that are smaller by a factor of 2 should decrease error 

by a factor of 4, but will increase the simulation run time by a factor of 16. 

1. On the Model menu, click Edit Meshes. 

2. Click New. 

3. Click OK to create the mesh. 

4. In the Min X box, type –1 and in the Max X box, type 1. 

5. In the Min Y box, type –1 and in the Max Y box, type 1. 

6. In the Min Z box, type 0 and in the Max Z box, type 3. 

7. In the X Cells box, type 20. 

8. In the Y Cells box, type 20. 

9. In the Z Cells box, type 30. 

10. Click OK to save changes and close the Edit Meshes dialog. 

11. On the View menu, click Fill View to resize the image. 
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Figure 2. Creating the mesh 

Define the Reaction 
For simulations that include combustion, the user must define a reaction. 

1. On the Model menu, click Edit Reactions. 

2. Click Add From Library. 

3. Select the POLYURETHANE_GM27 reaction and add it to the current model.  

4. Click Close. 

5. Click OK to close the Edit Reactions dialog. 

Create the Fire Surface 
Surfaces are used to define the properties of objects in your FDS model. In this example, we define a 

burner (fire) surface that releases fuel at a rate corresponding to 1000 kW/m2. By default, all surfaces in 

FDS are INERT and remain at a fixed temperature (usually ambient). We want to specify the temperature 
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of the burner surface, but the possible range is large. A pool fire may remain near the boiling point of 

the liquid (50-100 °C), ignition temperatures for wood range from 200-700 °C (Babrauskas, 2001), and a 

porous burner with natural gas as fuel can range from 530-750 °C (FDS Validation Guide based on 

McCaffre, 1979). We will assume 500 °C.  

1. On the Model menu, click Edit Surfaces. 

2. Click New. 

3. In the Surface Name box, type Fire. 

4. In the Surface Type list, for Surface Type select Burner. 

5. Click OK to create the new burner surface. The default heat release values are satisfactory 

(Figure 3). 

6. On the Thermal tab, select Fixed Temperature for Boundary Condition Model. In the Surface 

Temperature box type 500, and in the Emissivity box type 0.9. 

7. Click OK to save changes and close the Edit Surfaces dialog. 

 

Figure 3. Default parameters for the burner surface 
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Create the Fire 
To locate the fire (fuel source) in our model, we create an obstruction and assign the fire surface to the 

top of the obstruction. If the fire was on a model boundary, we could just use a vent and not include an 

obstruction.  

First we create the obstruction: 

1. On the Model menu, click New Obstruction. 

2. In the ID box, type Fire Obstruction. 

3. Click the Geometry tab. 

4. In the Min X box, type –.5 and in the Max X box, type .5. 

5. In the Min Y box, type –.5 and in the Max Y box, type .5. 

6. In the Min Z box, type 0 and in the Max Z box, type .2. 

7. Click the Surfaces tab. 

8. Click Multiple. 

9. For the Max Z surface, select Fire. 

10. Click OK to create the new obstruction. 

Note that we have made sure that the geometry of the obstruction corresponds to the cell size of 0.1 m. 

This removes any uncertainty as to what dimensions the obstruction will snap to. The top surface area is 

1.0 m2, so the total heat release rate will be 1000 kW. 

Open Sides and Top of the Mesh 
We want the sides and top of the mesh to be open to air flow. This is accomplished by creating open 

surfaces on these boundaries. PyroSim can automatically do this for all the boundaries of a mesh. 

1. In the Tree view, right-click Mesh01 and click Open Mesh Boundaries. This will create six new 

open vents on all sides of the mesh. 

2. Since we want the bottom to be closed, select the vent Mesh Vent: Mesh01 [ZMIN] and delete 

it. 
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Figure 4: Create open mesh boundaries 

Add a Thermocouple 
1. On the Devices menu, click New Thermocouple. 

2. In the Device Name box, type Thermocouple at 1.5 m. 

3. On the Location row, in the Z box, type 1.5. 

4. Click OK to create the thermocouple. It will appear as a yellow dot in the center of the model. 

5. On the toolbar, click the Show Labels button to toggle the labels on and off. 

Add Slice Planes (Contour planes) 
1. On the Output menu, click 2D Slices. 

2. In the XYZ Plane column, click the input cell and select Y. 

3. In the Plane Value column, click the cell and type 0. 

4. In the Gas Phase Quantity column, click the cell and select Temperature. 

5. In the Use Vector? column, select NO. 

6. In the Cell Centered? column, select NO. 

7. Click OK to create the slice plane. 

8. Repeat, but this time plot Heat Release Rate per Unit Volume. 

9. Repeat, but this time plot Velocity and select YES for vectors. 

10. Now add a plot for air volume fraction. In the Gas Phase Quantity column, click and scroll to the 

top of the list. Select [Species Quantity], then for Quantity select Volume Fraction and for 

Species select Air. Click OK. Select NO for vectors and cell centered. Press the ENTER key for a 

new line. 

11. Repeat so that you are plotting the Volume Fraction of AIR, PRODUCTS, and REAC_FUEL. See 

Figure 5. These plots will show us where the reaction is occurring. Air is supplied from the open 

boundaries, fuel is supplied by the fire surface, and products are the result of combustion.  
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12. Click OK to close the Animated Planar Slices dialog. 

13. On the toolbar, click the Show Slices button to toggle the slice planes on and off. 

 

Figure 5: Defining the slice plane plots. 

Add a Steady State Line Temperature Measurement 
Steady state line measurements simplify the output of a quantity on a line. By default, this device 

averages the output over the second half of a simulation. 

1. On the Output menu, click Statistics. 

2. Click New. For the Quantity, select Temperature. Click OK. 

3. In the Statistic Type box, select Temporal. 

4. Click Line Statistics. 

5. Select Steady State Profile. 

6. For Num Points, type 50. 

7. Change Point 1 Z to 0.2. 

8. Change Point 2 Z to 3.0. 

9. Click OK to create the device. 

10. On the toolbar, click the Statistics Regions button to toggle the line on and off. 

Rotate the Model for a Better View 
1. To reset the zoom and properly center the model, press CTRL+R. PyroSim will now be looking 

straight down at the model along the Z axis. 

2. Press the left mouse button in the 3D View and drag to rotate the model.  In Figure 6, the 

burner is shown in red and the thermocouple as a yellow dot. The open vents are blue. 
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Figure 6. The Burner Fire model 

Save the Model 
1. On the File menu, click Save. 

2. Choose a location to save the model (usually a new folder). For this example, we will create a 

Burner Fire folder and name the file burner fire. 

3. Click OK to save the model. 

Run the Simulation 
1. On the FDS menu, click Run FDS. 

2. The FDS Simulation dialog will appear and display the progress of the simulation. By default, 

PyroSim specifies an end time of 10 seconds. When the simulation is complete, PyroSim Results 

will start and display a 3D still image of the model. 

View Smoke in 3D 
1. In the PyroSim Results window, double click 3D Smoke to load the HRRPUV and Soot Mass 

Fraction datasets.  

2. To clear the display in PyroSim Results, double click 3D Smoke once more. 
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Figure 7: A plot of smoke and heat release rate per unit volume. 

Air, Fuel, and Products Contours 
At any location, the volume fractions of air, fuel, and products will sum to 1. Typical contours of these 

quantities are shown in Figure 8. Air is most of the volume fraction for most of the model. The fuel is 

released from the fire surface and the products result from mixing of the fuel and air. A plot of Heat 

Release Rate per Unit Volume (HRRPUV) shows the locations of combustion. 

   
 

a. Air b. Fuel c. Products  
Figure 8: Contours of the air, fuel, and products volume fractions. Blue corresponds to zero and red to 

1. 
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As a mechanical engineer, I initially assumed (incorrectly) that the heat release rate was just a simple 

heat source, not a fuel vapor that burns. I did not understand that if we specify heat release rate and 

combustion, the simulated fire will vary with time, depending on the mixing and ventilation. In fact, if 

the mesh boundaries are not large enough, the unburned fuel vapor will be carried out of the model 

bounds and the model heat release rate will never reach the specified value. 

 

Figure 9: Calculated heat release rate. This is obtained by integrating the heat release rate per unit 

volume over the model domain. The specified HRR was 1000 kW. The calculated HRR varies with time 

as the fuel mixes with the air and results in combustion. 

View Temperature Measurements 
The output of the devices such as thermocouples can be plotted: 

1. In the PyroSim window, on the Analysis menu, click Plot Time History Results. 

2. A dialog will appear showing the different types of 2D results that are available. Select 

burner_devc.csv and click Open to view the temperature device output. 



 

 Burner Fire  

 

11 
 

  

Figure 10. Temperature time history plot 

View Steady State Temperature Line Measurement 
The output of the devices such as thermocouples can be plotted: 

1. In the burner_fire folder and open the burner_fire_line.csv file. 

2. Plot the output data (Figure 11).  
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Figure 11. Line plot of steady state temperature above fire 



 

 

 

References 
Babrauskas, V., 2001. Ignition of Wood: A Review of the State of the Art, pp. 71-88 in Interflam 2001, 

Interscience Communications Ltd., London. 

FDS-SMV Official Website. https://pages.nist.gov/fds-smv/. 

McCaffrey, Bernard, 1979. Purely Bouyant Diffusion Flames: Some Experimental Results. National 

Bureau of Standards. NBSIR 79-1910. 

McGrattan, Kevin, et al. 2017. Fire Dynamics Simulator Technical Reference Guide (Sixth Edition). 

Gaithersburg, Maryland, USA, November 2017. NIST Special Publication 1018-1. 

McGrattan, Kevin, et al. 2017. Fire Dynamics Simulator User's Guide (Sixth Edition). Gaithersburg, 

Maryland, USA, November 2017. NIST Special Publication 1019. 

 


